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Introduction TC "Introduction" \f C \l "1" 
This document describes how to use the equipment and software of the IT lab. Please keep it with you until you can remember everything on it. 

Before you can use the system you should have a letter telling you 

· your own user name

· your Windows XP password

Your user name is public.  Your password is supposed to be private to you and you should NOT reveal them to anyone else.  As soon as you are confident about the system, you should change the password you have been issued with by the system support staff to something you choose for yourself.

Logging on TC "Logging on" \f C \l "1" 
Windows XP is a multi-user operating system. You always need to log on before starting to work at a computer. Logging on gives you access to your own files. 

1. Press Ctrl+Alt+Delete  (hold down Ctrl and Alt and then press Delete) to begin logging on.

2. Enter your username, DON’T press ENTER, press TAB or use the mouse to move the cursor to the password box and enter your password. 

3. Check that the domain box is set to DCS (change it if not)
4. Press ENTER or click on the OK button. 

· Occasionally you may be informed of a slow network connection and asked if you want to download your profile or use a local copy. You should always select download.  
To change your XP Password TC "To change your XP Password" \f C \l "2"  

It is easy to change your password whenever you choose. Press Ctrl+Alt+Delete and click the Change Password button in the XP security dialog box.  Then just follow the on-screen instructions to change your password to something that you can easily remember – BUT it should not be a recognisable word and should contain a mixture of upper and lower case characters, and digits, about 8 characters long.

· Make a note of your user name and password - nobody else knows the password and it’ll be inconvenient for you if you lose it. 

Unix password TC "Unix password" \f C \l "2" 
This allows you to access servers running on a different operating system to Windows XP. You will not do this in the early part of the course, but you will need to when for example you develop your own web pages.  Keep the letter containing your Unix password safely and securely until it is required.

At The End Of A Session : Logging off TC "At The End Of A Session : Logging off" \f C \l "2" 
When you have finished work for the time being, don’t just walk away from the PC. To secure your files, you must log off before leaving the computer. If you forget to log off, your account and files are accessible to anyone else who sits at the machine. They may abuse your account—copying or deleting your files, or sending offensive e-mail in your name.

To protect your files, your account will be automatically closed down if you do not use the computer for 20 minutes.

To Log off:

1. Press Ctrl+Alt+Delete 

2. This brings up the XP security dialogue. Choose Logoff 
THE DESKTOP TC "THE DESKTOP" \f C \l "1" 
Having logged on, what you see on the screen is called the desktop. 

The content and appearance of the desktop are standardised for all users of the lab. Any changes you make to it will be discarded when you log off.

Icons on the screen TC "Icons on the screen" \f C \l "2" 
This computer  & other file systems

The lab has many PC client computers, connected by a fast local area network (LAN) to the server. The IT server is called FS4. You use programs that run on the PC client (the machine you are sitting at), but your files are created, saved and edited in your own home directory on the server.

An icon for the PC’s file system appears at top left on the desktop. In much XP documentation it is referred to as My Computer, but in the IT lab each PC has a different label, reflecting that PC’s unique identifier and location. eg. BO1028-1-04. 

Double-clicking this icon opens a window that lists the various file systems accessible to you. 

These include:


the file system of the client itself (C:,D:). 

the DVD drive (E:) 

the network file system, (H: users on fs4 ) which is where your files are held in your  workspace

You can open your own workspace on Fs4 by double clicking on the H: icon..

Shortcuts TC "Shortcuts" \f C \l "2" 
A few shortcut icons have been provided for easy access to the most commonly used files or programs : your own workspace on Fs4 (Home on ‘fs4’),  the it library (IT Lib), mail (Outlook), the web (Internet explorer), NetScape…...

ItLib : the it library TC "ItLib : the it library" \f C \l "2" 
Look in here for any files, programs or documentation that we supply for you. Copy them to your own workspace before using them.  Remember that you only have Read permission on ITLib and so cannot edit documents or execute programs that are in files on ITLib

The Recycle Bin TC "The Recycle Bin" \f C \l "2" 
Drag files to be deleted to the Recycle Bin.
WARNING : files deleted from a server cannot be retrieved from the Recycle Bin.  

Finding out about XP TC "Finding out about XP" \f C \l "1" 
There’s a lot of information in this user guide, and there are other ways too:
· You can discover the function of a toolbar button or a menu command by holding the mouse over it for a few seconds, and looking at the pop up tooltip that appears. 

· Do make use of the on-line help and other documentation that is available. Windows XP help can be invoked directly from the Start button, and many applications have their own Help menu. In addition, some applications have on-line documentation available from Start button sub-menus.

Task bar : starting programs and switching windows TC "Task bar : starting programs and switching windows" \f C \l "1" 
The task bar appears at the bottom of your screen. (It sometimes retreats below the lower edge and becomes invisible. You can usually bring it back by moving the mouse cursor to it.) It contains the Start button (bottom-left) which you use to start a program, create a new document etc. You can also use it to invoke the Windows XP help facility. 

Switching windows

When you open a program, document, or window, a new button appears on the task bar. Clicking a button brings the corresponding window to the front. You can use this to switch between the windows that you have open.
Manipulating windows TC "Manipulating windows" \f C \l "1" 
· Windows in XP have a title bar which can be used to drag the window around the screen. 

· There are three buttons at the right end of the title bar, with the following functions:

· The leftmost, minimise, button hides the window but leaves the application running. You can make the window visible again by clicking its button on the task bar.

· The middle, maximise, button makes the window the size of the entire screen. Clicking it a second time returns the window to its original size. 

· The rightmost, close, button closes the window; if it contains information you have edited, you will be asked whether you want to save it before closing.

· You can resize the window by dragging any edge in the direction you want to change.

· Some windows have sub-windows inside them. These usually have their own control buttons and can be closed, minimised, etc without affecting the main window.

Menus and commands TC "Menus and commands" \f C \l "1" 
· Main windows have a list of menus immediately under the title bar. Each menu is a pop-up list of commands. The menu pops up when you click on it. (If you do this by mistake, click on the title bar and it will go away.) 

· An alternative way of activating a menu is to type its key letter (the one that is shown underlined, e.g. F in the File menu), while holding down the Alt key.

· With the menu activated, you can invoke a command by clicking on it with the mouse. If you activated the menu using Alt, you can also invoke a command by keeping Alt pressed and typing its key letter (e.g. Alt+F immediately followed by Alt+C invokes the File:Close command). 

· Many menu commands can be invoked from a button in the toolbar, just below the menus. If you hold the mouse over a button for a few seconds, you are given a description of the button’s function.

· Yet another, even quicker, way to invoke a command is to type its keyboard shortcut (if it has one). Where available, this is shown beside the command name in the menu. These shortcuts use the control key in combination with another key to identify the command in a single step, without first having to activate the menu. Many programs provide a consistent set of keyboard shortcuts for the Copy (Ctrl+C), Paste (Ctrl+V), Cut (Ctrl+X) and Undo (Ctrl+Z) operations.

· You can click any item with your right mouse button to see a shortcut menu. This offers specific commands that can be applied to the item. For example, by clicking a file with the right mouse button, you can choose to open, print, copy, delete, etc. Other useful shortcut menu items include being able to empty the Recycle Bin (right-click on the Recycle Bin).

What To Do When Things Go Wrong TC "What To Do When Things Go Wrong" \f C \l "1" 
Application frozen

· Press Ctrl & Alt & Delete. This usually brings up the XP security dialog.  From this you can access the Task manager.  With luck you will be able to identify the frozen application, and you can highlight it and select End Task.
If Ctrl & Alt & Delete fails, the machine may have to be switched off.  The ON/OFF switch is a round blue button on the system unit.  It must be pressed for about 10 seconds in order to have any effect.  This should only be done as a very last resort.  Switching the machine off can corrupt its file system and it may become unusable.

More on Files TC "More on Files" \f C \l "1" 
All of your files are held on the server, in a folder named with your user name. No one else is permitted to change the files stored in your home folder; and no one but you and the system staff can read them. 

The system treats your home folder as the logical H drive on your current workstation,  A few folders have already been created for you.  We suggest that you put all your work into the Workspace folder provided, and leave the other folders strictly alone.  Inside your Workspace folder you will find other folders labelled Prog, IM and NBData.  The Prog folder is for storing all your Java programs, the IM folder is for your Information Management practical work and the NBData folder is there for historical reasons.

The structure of the tree of folders set up for you in your home space is shown in the diagram:





You should organise your work on the computer by creating your own folders inside the existing folders in order to store related files together.  The quickest way to create a new folder inside another folder is to right click anywhere inside the existing folder window and select New from the drop down menu.
Working with files TC "Working with files" \f C \l "1" 
There are two normal ways to open a file using the GUI. 

· One method is to double-click its icon in a folder window. 

· The other method is to open a file from inside a dialogue displayed by a suitable application program. 




Use this File Dialogue Box to Navigate to a file or folder              

· For example, to open a file from a text editor, you would choose the Open command from its File menu (File:Open). 

· You can look in a nested folder (if there is one) by double-clicking on its name in the scrolling list box, or by selecting its name and clicking on the Open button. 

· You can go to a folder elsewhere in the hierarchy by using the popup menu above the list. 

· When you have located the file you want, you can either double-click on it, or select it and click on the Open button, to open it.

Saving a file TC "Saving a file" \f C \l "2" 
You are recommended to save your work in a suitable folder in your workspace on the server.

Every time you open a file, a copy of it is sent from the server, over the network, to the PC. When you save a file, the updated version is sent back to the server, and replaces the original.  

It is also possible to save files in the Workspace on the D drive of the computer you are sitting at (sometimes called My Documents). You may prefer this if the network is slow, but you MUST then remember to copy the files to your own workspace on the server before you log off. Files in the D drive workspace will be deleted when you log off. They are moved temporarily to the Lost & Found folder and can be retrieved from there, during the next 2 days only.  You will need to contact the system support staff (email support) if you want to retrieve files lost in this way.

Viewing Files TC "Viewing Files" \f C \l "2" 
You can look at the files in your Workspace using Windows XP Explorer, or by opening folder windows, starting with your Home On FS4 shortcut.

· PC files are usually saved with a 3 character extension indicating the type of file. Eg .doc, .txt, .xls
If you create a file using an appropriate application, it will usually be given the correct extension (type) automatically.

· You can customise the way you view the files in a folder by using commands in the View menu of the folder window.

Copying Files TC "Copying Files" \f C \l "2" 
The simplest way to copy a file from one folder to another is:

· Open windows for both the source folder and the target folder

· Right click on the icon for the file you want to copy and select Copy from the drop down menu

· Right click on a blank bit of the target folder and select Paste from the drop down menu.

Backing up files TC "Backing up files" \f C \l "2" 
· Your files on the server will be backed-up automatically, probably once a day. This means that safety copies of files are made, so that they can be restored to their earlier condition in the (unlikely) event of a serious failure that causes loss or corruption of the server’s hard disks. 
· These back-up copies are not intended to provide you with a way of recovering from careless deletion or disastrous mis-editing of your files—a recent-enough copy to save you significant effort may not exist, as files are backed-up relatively infrequently. However, if you lose or hopelessly mis-edit a major file close to a deadline, it is worth asking support if it can be recovered from the backup, as long as you bear in mind that this may not be possible.
· If you want to take your files home to work on there are a number of options
a) There are about six machines (one per bench) with floppy drives in the IT lab.  You can log onto one of those and copy your work onto a floppy disk.  Remember that a floppy drive will only hold about 1.5Mb of data

b) All the machines in the lab have USB ports in which you can use a Pen Drive.  If you have a USB drive on your home machine then this is an excellent alternative to a floppy drive.

c) If you have an email account at home you can email files from your University account to your home account.

Printing TC "Printing" \f C \l "1" 
NB:  When you log on, your default printer will always be one of the printers in the IT lab –lab 1028.  During the foundation course you may be in some other lab.  In this case you must either change the default printer or choose a printer in your lab each time you print anything, otherwise you will have to go to 1028 to retrieve your work.

To change the default printer

· From the Start menu select Settings : Printers

· Highlight the printer you wish to be your default

· From the File menu select Set As Default

To print a file

· Select the Print command in the File menu. Your work is sent to whichever printer in lab 1028 has the shortest queue. 

· However you can override this if required, by altering the printer name in the print dialogue box.  The method for doing this varies according to the application.

· If you click on the printer icon in an application, often the print dialogue box does not appear and the file is sent automatically to the print queue of the default printer.

· You can see where your file is in the print queue, relative to other users’ print jobs, by double-clicking on Start : Settings:Printers. Double click on a printer. You can remove your own file from the print queue by selecting it and using the queue’s command Document:Cancel. 

Printing part of the screen

You can’t send this directly to the printer, the keys you press will send a picture of the file to the Clipboard (a temporary storage area), you then have to paste the picture into a suitable program and print from there:

· To copy a window that’s currently active, press Alt & PrintScreen.

· To copy the entire screen, press PrintScreen.

1. Open a document such as Word using Start:Programs:Microsoft Office:Word.

2. Select Edit : Paste to insert the picture of the window into the document. 

3. Add your name and any other details

4. Select File : Print  from the program menu.

Hardware/ software faults TC "Hardware/ software faults" \f C \l "1" 
Please report all faults, to enable the fault to be fixed as soon as possible. If you have an apparent hardware or software fault, get help from a tutor or demonstrator if there is one available. If not, or if your helper cannot resolve the problem, pass it on to the support staff as follows: 

· If a PC clearly has a hardware fault (such as a disconnected keyboard), leave a note in the Lab’s Fault Book. It is a courtesy also to leave a note on the PC itself to warn any future users. Check the Fault Book from time to time to see that faults are being cleared. If they are not, report this to your tutor.

· In any case, report the problem by email to support, being sure that you have identified the symptoms accurately enough to allow efficient diagnosis and cure. Include as much of the following as is appropriate:

• what the problem is

• what you were doing when the problem occurred

• the text, verbatim if possible, of any error message

• an explanation of any measures already taken

• the name of the machine

· If the fault prevents you from using email, ask someone else in the lab to send the email on your behalf. Failing that, leave a note in the Lab’s Fault Book. (It should be looked at every day without fail, and the support person should sign each item to acknowledge that it is being dealt with.)

H:\ = Home on FS4





MSc IT COURSE


IT Lab:  User Guide





Change file type here if necessary





Pop up menu





Move up a directory





easyphp





Workspace


NBData


	Prog


	IM














MSc/PGDip Information Technologu
Lab User Guide                                                                        1 


